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Adding AuditAdvanced content to an existing file

There are a number of steps in the process which must be followed closely, but this method
preserves the current set of financial statements and adds an audit pack to the
engagement.

This procedure will normally be carried out at the start of the engagement, after rolling
forward the engagement file from the previous period.

Open the file that is to receive the new audit documents and make sure the ‘Document
Manager’ is on screen.

Step 1 - Tidy up of the Document Manager

The engagement file may already contain a set of lead schedules and other working papers,
and the user should decide which of these they want to retain and which to delete. To retain
the Accounts Preparation and Corporation Tax components of the file, the following
documents must remain:

., Accounts

| Lead schedules / Audit

. Full Assurance (CW Assurance)
| Lead schedules & working papers (Mercia) No longer
. Version required

. Control files

| Corporation Tax |

o e . o R —

LY IR AR Y YR .

Any existing Audit content MUST be deleted.

Preserving additional working papers

To preserve any existing working papers, create a new folder and move any additional
working papers including Excel, Word and PDF documents into this folder. These can be
redistributed into the new folder structure later in the process.

Alternatively, you may decide to simply copy such documents from the prior year
engagement file once the process is finished.
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This function will help to remove any potentially sensitive information from your
engagement. Use ‘Cleanup’ to remove any legacy history and milestones from your
engagement file before you start on the current year’s audit:

This wizard helps to clean potentially sensitive information from the file, Any
decuments and issues not marked for retention on cleanup will be removed.

a? Welcome to the Engagement Cleanup Wizard

The following cptions are available:

(] Retain History

Retain Milestones

To continue, click Mext,

< Bac Mext = Cancel Help

Once you have chosen which areas you would like to retain during the ‘Cleanup’ process,
select ‘Finish’:

Engagement Cleanup Wizard
Once you proceed, the following cleanup tasks will be peformed:

" History will be deleted
v Milestones will be deleted

<

To proceed, click Finish,

< Back Finish Cancel Help
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&l File | Edit View Insert Engager
O | New Select ‘File’-*Copy Components’ from
1 the main toolbar menu
Dpen..
% H \ H H 7
Close Y Select the option ‘Copy Into This File
r '@ Copy Components... %
r
Welcome to the Copy Componeyits Wizard
This wizard allows you to copy all or some copiponents from ene client file to another.
Please select the type of copy you wish tg/perform
Copy Into This File
> Compeonents from another client file will be copied into the currently open client file
(ABC Motor Company Limited 2016).
Copy Into A New File
> A new client file will be created, Components from the currently open file (ABC Moter
Company Limited 2016) will be copied into the new file.
Copy Into An Existing File
> Components will be copied from the currently epen file (ABC Motor Company Limited
2016) inte an existing file.
To continue, click Mext.
< Back Mext > Cancel Help
Then select the appropriate AuditAdvanced template based on the entity type:
File Recent Template
d @ & @ @0 & §d « <
Academies  Academy Accounts  AccountsAdv BranchAcc.. Charity Audit  Charity Company HAT
Template Audit Template Template Template Audit Unincorpor...
« @ & @ 9
HAT Working  LLP Audit  MonCorp3 Pension Trust
Papers Scheme Template
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Step 4 - Select the documents to be added

Select the documents that you wish to add to the current accounts file. For the purposes of
this exercise that will mean every schedule.

Copy Components Wizard

Copy Components

Please select which components you want to copy to the destination file,

(O All Components

® The following components

lnnponems

[JGroupings/Mapping
[issues

[Tags

[JRole Sets
[CTickmarks

[JJournal Types

[ Trial Balance
[]Document Filters
[JTemplate Toolbar
[layout

[(JHistory Settings

[JUser Defined Data

[JCV External Data
[[]CaseView Repository Files
[JMapping Purges

Click on the
‘Documents’ checkbox

Document Filter: All Documents

Name
v [4] | Assurance
[ (€] PRELIM Preliminary Tailoring Checklist
@AOCR Audit optimiser confirmation report
@ DSORPT Decument sign-off report
~ [ | File Administration
~ [4] || Control Documents
¥ [ 1. Update
DOCVER Document version report
UPDATE CWUpdate
CWSUPPORT CaseWare support document
~ [7] | Version
&) vERsION Version Document
CHANGES Changes in this Version

<

Click the ‘Select All
button, to ensure that
every master audit
document is going to
be included in this file

[ Copy Decuments only (no folders) | Select All

[ Show empty folders

| <Back || mMet» ||

Ensure that the ‘Copy
Documents...” and
‘Show empty folders’
checkboxes are
unticked, as shown
here

DO NOT SELECT ‘NEXT’ AT THIS STAGE

V1.0
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Step 5 - Issues

The existing accounts files will be structured to manage Issues (review points) in
accordance with the previous Mercia file structure and these will need to be replaced with
the new Issues formats.

From the Copy Components screen select ‘Issues’ and then select the checkbox options for
‘Views’ and ‘Types’, ensuring the ‘Behaviour’ settings are set to ‘Replace’, as seen below:

Copy Components Wizard >

Copy Components
Please select which components you want to copy to the destination file,

(O All Components
(®) The following components

[#] Documents

[ Groupings/Mapping Copy Behaviour
] Views  Replace

Tags

ERolge Sets [ Types  Replace

[ Tickmarks [ Issues  Merge and update if newer (older existing issues will be overwritten)

[Mlournal Types

[ Trial Balance

[ Document Filters

[JTemplate Toolbar

[Layout

[History Settings

[JUser Defined Data

[C]CV External Data

[] CaseView Repository Files

[IMapping Purges

< Back || Mext = | | Cancel | | Help

Step 6 - Tags

Simply select the checkbox, no further settings are required.
Step 7 - Role Sets

Simply select the checkbox, no further settings are required.
Step 8 - Tickmarks

The AuditAdvanced templates comes with a selection of predefined ‘Tickmark’ options. If
custom Tickmarks have already been configured in the file at hand, this option may be
ignored. To accept the new Tickmarks, simply select the checkbox, no further settings are
required.
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At this stage the Copy Components wizard should display the following choices:

Copy Components
Please select which compoenents you want to copy to the destination file,

(O All Components

(®) The following components
Components Tickmarks
[#]Documents
[[]Groupings/Mapping
[“]lssues

[ Tags

[]Role Sets

(M| Tickmarks
[Journal Types
[1Trial Balance

Select this eption to copy the standard and customized tickmarks and any extended
descriptions to the destination file,

The following will be copied:

[]Document Filters C Calculated
[JTemplate Toolbar CK  Agreeto cheque
Otayout FS  Forward to F/S
[JHistory Settings

| Agree to invoice
NA Mot applicable
NM Mot material

P Agree to prier

[JUser Defined Data

[1CV External Data
[[]CaseView Repository Files
[[Mapping Purges

5 Agree to statement
UD  Forward to U/D

Z Cross added

A Agree to G/L

~ Added

FODRRY R B %S

< Back Mext > Cancel Help

Hit ‘Next’ to confirm, to move on to the next screen, leave this screen untouched and hit
‘Next’ again to arrive at the summary screen:

Copy Components Wizard Complete
Once you proceed the following copy actions will be peformed:

Copy to C\Program Files (x88)\CaseWare\Data\test2\test2.ac
Copy from C:\Program Files (x86)\CaseWare\Document Librany\Company Audit\Company Audit.ac
= Components will be copied

Documents

lssues

Role Sets

Tags

To proceed, click Finish.

< Back Finish Cancel Help

Hit ‘Finish’ to complete the process. You may be asked to login at this point if security has
been enabled on the template.
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The AuditAdvanced system uses Group 6 TB references to populate certain schedules (e.g.
the B32_FSA). These references will not currently exist in jobs that were not originally
based on an AuditAdvanced template. In order to manually populate the Group 6
references into a file, users can use the CWGP6 document.

This document can be launched from the Browser bar seen below:

Q File Edit View Insert Engagement Document Account Tools Window Help
0P R B XD 0|3 E" | @ % B D& - o Yearly ~
Documents Issues Trial Balance  Adj. Entries Other Entries Cloud G Back E] b | CWGPE v‘ | 0 @ g
I‘T Filter: None

The following CaseView document will open:

AuditAdvanced Group 6 Update

1) Create a backup of the file to use for reference after the update.

2) This update is run after integrating an AccountsAdvanced and an AuditAdvanced file.
3) This update only applies where FRS101/102 mapping is being used.

4) This update links new groupings and mappings for Accounts and Audit Advanced.

5) Full details of AccountsAdvanced can be found in the documentation accompanying this release

| have read these notes and taken a backup. El

Update Group & Mapping

Once the user has indicated that a backup of the file has been taken, the ‘Update Group 6
Mapping’ button can be used to complete the process.

mportant .

Close CaseWare and reopen. Click OK, then close

Once this is done the Conversion is complete, the file and reopen
before continuing

OK/

V1.0 8



7

CASEWARE

CaseWare Training | Adding AuditAdvanced (v16) to AccountsAdvanced files

TRAINING

Step 11 - Applying the Dashboard layout

To apply the new dashboard layout for AuditAdvanced, select Tools — Options, and on the
Layout section select the Workflow for the relevant template (e.g. ‘Company Audit
Workflow") from the menu, as shown below.

Options *

General A layout template is a windew layout plus a set of scripts, images, decuments, HTML
Default Paths templates, and other elements to help you customize your interface.

Roles Lavout template;
Company Audit Workflow ~

Groupings
Mapping
General
Autofill
Purge
Documents
Data Store
Lists
Journals
Tax Codes
Units

Custom Balances

Description:

The Digital Dashboard layout walks you through using Working Papers to prepare
your file,

Language
Layout
CaseWare Cloud
Advanced

Cancel || Help |

Click on ‘OK’ after making the selection. The file will now display the AuditAdvanced
dashboard layout:

Welcome Add New Tab

Options ~

Planning and Risk Assessment Audit Programmes Completion and Reporting

Financial Statements and

Preliminary Assignment Appointment and R.I
Tailoring Signatures
- Communication with Client
o] and Engagement Lefter
Preliminary Analylical Review The Entily and lis Environment

Internal Control Assessment Materiality
Team Discussions

Audit Approach and Work
Programme Planning
Engagement Quality Control Group Audit Specific
Review Documents

Going Concem

Risk Assessment and Risk

Report

D - Directors and related
parties
E-Fixed assets
F-Investments

H - Income and Debtors
1-Bank and Cash
J - Expenditure and creditors
K- Provisions, contingendies
and commitments
L - Capital and resenves

and
consolidation

Disclosure Checklists

Opinion and R|. Signatures.

File Review and Issues

Ethics Review and Audit
Completion

‘Completion Evidence

Client Communication

Forward Planning

Final Update

Engagement Quality Control

Group Audit Spedific
Documents

V1.0
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Step 12 - Update Lead Schedule references

The AuditAdvanced dashboard should now be showing. The Welcome tab will prompt users
to update the references on the newly added lead schedules:

Workflow Accounts Add Mew\h | Options ~ |

Engagement set up

Flease select the documents to be included in this file:

Accounts documents

Lead schedules need updating for FRS101/102, please click here to complete.
Corporation tax documents

V1.0 10
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Step 13 - Importing standard Risks from the template

The following audit risks are built in to the AuditAdvanced templates:

e Management override
e Revenue recognition

These risks will therefore be included as standard on any files built from new based on the
AuditAdvanced templates. However, any files where the AuditAdvanced content is being
added manually, these risks will need to be created, or copied from the template as below:

Document Procedures  Areas  Options  Help
@~ zl | - 0~ @~ | B3| B~ | F H||k
Mew Risk I
Import Risks...
Documen :
. CaseWare® RiskSpace... . :
This docume it system, please answer all questio
ACCR to remaove documents that are not required.

In the next dialog, browse to and select the relevant AuditAdvanced template in the
Document Library folder (typically C:\Program Files (x86)\CaseWare\Document Library):

|E| Import Risks x

Risks may be imported from either template or client files. Click help for more details.
Import Source

|Files (x86)\CaseWare\Document Library\Company Audit\Company Audit.ad
Select Risks
Y |

4 [v] Other 2 rizis)

0 Management override
 Revenue recognition
—

Select all risks and
click OK to bring them
into the current file

< >

| oK || Cancel || Help

The risks will then be opened in the file and can be amended as necessary.
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It is good practice to refresh the General Options document. This can be found in the
Document Manager in the following location:

. Accounts
~ || Assurance
L@PRELIM Preliminary Tailoring Checklist
L@AOCR Audit optimiser confirmation report

\_f.;ﬂ DSORPT Document sign-off report
* || File Administration
% . Control Documents
. Update
.. Version Double click

¥ || Options to open
] EPT Firm informaticn
L@AG General options

L@ PROCALLRP Procedure allocation maintenance report

[ NEW New Client Doc
L@ROI Republic of Ireland Template
lcuk UK Template
€] MERCIA Mercia
. Master Documents
.. Year End Audit File
.| Corporation Tax

When the document opens, simply hit the ‘Refresh’ button:

General options can only be modified in the Master Template.

Engagement Profiles

Defined by the authar, engagement profiles allows the user to load the settings of any existing profile into the current engagement. Lodxiqg a profile will nat add or remove
documents in the current engagement file.

Last loaded profile: Default
Profile Description
* Default This profile will reset the engagement to the product installation default. \Aa

Once this has been done, the document can be closed.
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Step 15 - Configuring the B32 Risk Report

There will a couple of minor configuration changes required for the B32 Risk Report to
ensure it looks the same as any newly created file. Open this from the dashboard:

Risk Assessment and Risk Report *
Click on a mapping to launch it
B32_PF31 Risk Analysis
B32_PF32 Fraud Risk Analysis

Hisl‘{ AESEEEFTIEM End Rl'ﬁk B32_FRF-1 Change of Financial Reporting Framework [mpact Assessment
Repart e B32_FRF-2 Charge of Financial Repotting Frarework Risk Analysis
I E32 Risk report - Planning View I

[keep this dialog open unti closed.

Close

Click on the ‘Filters and Views' button, then select the ‘Planning View’ from the ‘View’ menu.

Document  Report Gptiana\HeLp\\ /
0- 0- @-|AH-KR FI| |0

L View: Default View / -

Free Form Risk Review ~
Categories: $&wiew : gmuped by bdsiness cycle
Date Identified: | O crView 1 Grouped :

] ) Overview 2 Grouped by business cycle

Risk Determinat) oy erview 3 Groupgd per FSA
Assertions: Print View 1

Print View 2

D] 5 i 5 v

If the Overall Risk column is missing in the report, please ensure step 12 has been
completed.
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Step 16 - Populate Part Il of the AOCR

During this process, it is possible that internal links between some of the Audit System
documents are temporarily lost. This will particularly be manifested in the AOCR document
where non-material areas do not populate part III of this form. To re-enable this function
open the B32_FSA document. From the B32 Risk Report, users can select the currency
button in the toolbar to access the B32_FSA:

Document  Report  Options  Help

O- 0~ @~ AEH- K &I F OB @ G

All of the Work Program links should be used to open each individual item:

Financial Statement Balances

Entty level and IT
general weaknesses and
controls

®C  Taxation - - - m] O 0o o O caoco c
#D Directors and Related - - - O oo o CEAV D
Parties ROOCL
co
WE1  Tangible Fixed Assets - - - ] [ R o R O ceav E

Once these documents have been opened, they can then be closed and saved. This should
be enough to reset the internal links. To check, from the B32_FSA, users can select the red
tick button in the toolbar to access the AOCR: /

Document Areas Options  Help /

2 @-0-@- 2| Flol DB

@

The file is now ready to be used. Any documents that were preserved in step 1 may now be
redistributed to their rightful position.

Please note all Risks (except for Management override and Revenue recognition) will need

to be recreated. Work programmes will need to be started from scratch. Permanent file
comments will need to be copied from the old file.
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Creating a brand new file instead

Alternatively, the user may opt to create a brand new file in AuditAdvanced to continue
with. The following steps can be taken to effectively get to the same position as mentioned
in the previous chapter:

1. Roll forward the old file as usual.

2. Create a new file based on the appropriate AuditAdvanced template.

3. Add in the relevant Accounts documents from the 'Welcome tab’ on the Dashboard.
WARNING: Please ensure the documents added are the same as those currently in the
old file mentioned in step 1 (i.e. if the conversion to AccountsAdvanced has not yet been
performed, please select UK GAAP documents to start with and convert later)

4. Now delete the Accounts documents.

5. Use the 'Copy Components’ feature to import ‘Documents’ (select just the Accounts
folder), 'Issues’, 'Trial Balance’ and 'CV External Data’ from the old file (from step 1) to
the new file (from steps 2 & 3).

6. Use Tools / Options / Autofill to select 'Autofill Now’ to update TB account properties.

7. Copy any other relevant Audit documentation from the Document Manager of the old file
to the new file, using the drag and drop method.

8. Risks will need to be recreated.
9. Work programmes will need to be rewritten.

10. Permanent file comments will need to be copied from the old file.
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